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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
MCP3421/2 SOT-23-6 Evaluation Board. Items discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Website

• Product Change Notification Service

• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes how to use the MCP3421/2 SOT-23-6 Evaluation Board as a 
development tool to emulate and debug firmware on a target board. The manual layout 
is as follows:

• Chapter 1. “Product Overview” – Short overview of the MCP3421/2 SOT-23-6 
Evaluation Board.

• Chapter 2. “PICkit™ Serial Analyzer” – Details about the PICkit™ Serial 
Analyzer and instructions on how to use it to obtain the ADC conversion results.

• Chapter 3. “MCP2221A Breakout Module” – Details about the MCP2221A 
Breakout Module.

• Appendix A. “Schematic and Layouts” – Shows the schematic and layout 
diagrams for the MCP3421/2 SOT-23-6 Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
MCP3421/2 SOT-23-6 Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics, to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user’s guide describes how to use the MCP3421/2 SOT-23-6 Evaluation Board. 
Other useful documents are listed below. The following Microchip documents are 
available and recommended as a supplemental reference resource:

MCP3421 Data Sheet – “18-Bit Analog-to-Digital Converter with I2C 
Interface and On-Board Reference” (DS20002003)

MCP3422/3/4 Data Sheet – “18-Bit, Multi-Channel  Analog-to-Digital 
Converter with I2C Interface and On-Board Reference” (DS20002088)

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE 

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive email notifications whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at 
https://www.microchip.com/en-us/support/product-change-notification and follow the 
registration instructions.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
https://www.microchip.com/support.
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Chapter 1.  Product Overview
1.1 INTRODUCTION
The following chapter provides an overview of the MCP3421/2 SOT-23-6 Evaluation 
Board and demonstrates how to use it with either the PICkit™ Serial Analyzer 
(DV164122) or the MCP2221A Breakout Module (ADM00559).

1.2 MCP3421/2 SOT-23-6 EVALUATION BOARD OVERVIEW

The MCP3421 and MCP3422 Evaluation Boards have a single-channel and 
dual-channel 18-bit  analog-to-digital converter (ADC), respectively. The 
MCP3421/2 SOT-23-6 Evaluation Board offers the following headers for simple 
interfacing: 

• Analog CH1± (MCP3421/2), CH2± (MCP3422) and GND header (J4)

• PICkit™ Serial Analyzer header (J3)

• MCP2221A Breakout Module interface header (J3)

• mikroBUS™ interface header (J1 and J2)

Figure 1-1 and Figure 1-2 show the top and the bottom of the MCP3421/2 SOT-23-6 
Evaluation Board. The user can connect any sensor input signal and test the ADC 
conversion results. Both the PICkit™ Serial Analyzer and the MCP2221A Breakout 
Module can provide a PC Graphic User Interface (GUI) for writing configuration 
registers and reading ADC conversion values from the MCP3421/2 SOT-23-6 
Evaluation Board. 

The PICkit™ Serial Analyzer connects the PC GUI to the MCP3421/2 SOT-23-6 
Evaluation Board via an I2C communication bus. The MCP2221A Breakout Module 
connects the PC GUI to the MCP3421/2 SOT-23-6 Evaluation Board via a USB to I2C 
communication bridge. 

FIGURE 1-1: Top and Bottom Views of the MCP3421 Evaluation Board 
(EV07U08A).
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FIGURE 1-2: Top and Bottom Views of the MCP3422 Evaluation Board 
(EV45V72A).

1.2.1 I2C Address Bits

The Device-Code and I2C Bus Address Bits for the MCP342XA0 devices are ‘1101’ 
and ‘000’, respectively. These bits are programmed at the factory during production.

The Device-Code and I2C Address Bits combine to form an I2C Control-Byte of ‘0x68’ 
for all Read and Write operations.   
DS50003483A-page 10   2023 Microchip Technology Inc. and its subsidiaries
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Chapter 2.  PICkit™ Serial Analyzer
2.1 GETTING STARTED WITH THE PICKIT™ SERIAL ANALYZER

2.1.1 PICkit™ Serial Analyzer and MCP3421/2 SOT-23-6 Evaluation 
Board Hardware Set-Up

The following steps describe how to connect the PICkit™ Serial Analyzer to the 
MCP3421/2 SOT-23-6 Evaluation Board: 

1. VDD selection: Use the VDD from the PICkit™ Serial Analyzer or use either the 
3.3V or 5V supply voltage from the mikroBUS header. Select the VDD path using 
the R1,R2, or R3 0Ω resistor/jumper: 

a) Connect R3, if using VDD from PICkit™ Serial Analyzer;

b)  Remove R3 and add a 0Ω resistor/jumper to R1 or R2 for 3.3V or 5V, 
respectively, from the mikroBUS header.

2. Connect the MCP3421/2 SOT-23-6 Evaluation Board’s J3 pin header to the 
PICkit™ Serial Analyzer, as shown in Figure 2-1.

3. LED D1 turns on when VDD is applied.

4. Connecting analog inputs: Connect the unused pin (example, VIN-) to VSS for 
single-ended measurements.

5. Use the PICkit™ Serial Analyzer PC GUI to send I2C Write and Read 
commands. See Section 2.2 “Creating Script Files”.

6. Execute the PICkit™ Serial Analyzer script file and obtain the ADC conversion 
results. The conversion results appear on the PICkit™ Serial Analyzer PC GUI.

CAUTION

The analog input pin has ESD diodes. Certain input conditions can damage the 
device. Please pay attention to the following conditions:

a) Do not apply input greater than the input range specified by the MCP3421 and 
MCP3422 data sheets;

b) Apply input signal after VDD is powered-up.
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FIGURE 2-1: MCP3421/2 SOT-23-6 Evaluation Board with the PICkit™ Serial 
Analyzer.
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PICkit™ Serial Analyzer
2.1.2 PICkit™ Serial Analyzer and MCP3421/2 SOT-23-6 Evaluation 
Board PC Software Set-up

The following steps describe how to set up the PICkit™ Serial Analyzer PC GUI to write 
the configuration bits of the MCP3421/2 devices and read the ADC conversion results.

1. Install the PICkit™ Serial Analyzer software on a PC.

2. Connect the USB cable between the PICkit™ Serial Analyzer and the PC.

3. Run the PICkit™ Serial PC Software. Figure 2-2 displays the GUI. Click the Next 
button to configure the PICkit™ Serial Analyzer.

FIGURE 2-2: PICkit™ Serial Analyzer Configuration Wizard Welcome Window.

4. Select the I2C Master option as communication mode, then click the Next 
button.

FIGURE 2-3: Communication Mode Selection.
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5. Select either 100 kHz or 400 kHz. Click the Next button.

FIGURE 2-4: I2C Communication Speed Window.

6. Select No, as shown in Figure 2-5, then click the Next button.

FIGURE 2-5: Device Pull-ups Window.

Note: The MCP3421/2 devices support the I2C bus data rate up to 3.4 MHz, but 
the current version of the PICkit™ Serial Analyzer supports an I2C bus data 
rate up to 400 kHz only.

Note: The MCP3421/2 SOT-23-6 Evaluation Board has its own pull-up resistors. 
Therefore, additional pull-up resistors from the PICkit™ Serial Analyzer are 
not needed. 
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7. Select the VDD voltage of the MCP3421/2 SOT-23-6 Evaluation Board and click 
the Next button.

FIGURE 2-6: Voltage Source Selection Window.

Case 1 – PICkit™ Serial Analyzer VDD power supply:

a) By choosing the “PICkit™ Serial will power my device” option and selecting 
the 5 Volt radio button, as shown in Figure 2-6, the MCP3421/2 SOT-23-6 
Evaluation Board will be powered by the 5V DC output of the PICkit™ Serial 
Analyzer through the R3 0 resistor/jumper.

Case 2 – External VDD power supply:

a) Option 1 - mikroBUS header with an 8/16/32-Bit Microchip Evaluation Board:
In this case, either R1 or R2 can be populated with a 0 resistor/jumper.

b) Option 2 - mikroBUS header without an 8/16/32-Bit Microchip Evaluation 
Board:
In this case, either R1 or R2 can be populated with a 0 resistor/jumper with 
an external power supply applied to the 3.3V pad at J1 or the 5V pad at J2 
of the mikroBUS header.

8. Click the OK button to complete the configuration. The MCP3421/2 SOT-23-6 
Evaluation Board can now be configured using the PICkit™ Serial Analyzer.

FIGURE 2-7: Configuration Wizard – Final Step.
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2.2 CREATING SCRIPT FILES

To establish communication between the PICkit™ Serial Analyzer and the MCP3421/2 
SOT-23-6 Evaluation Board, a Script File is needed. The following sections explain I2C 
Script Files for the MCP3421/MCP3422 Read/Write operations. 

2.2.1 Creating a Script File

To create an I2C Command Script for Read and Write operations of the MCP3421/2 
devices, click the Communication tab from the Top Bar menu, then select Script, then 
click the Script Builder option, as shown in Figure 2-8.

FIGURE 2-8: Creating a Script File with Script Builder.
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2.2.2 Writing the Configuration Register

1. Click the WriteBlockAddrA8 in the “Example I2C Scripts” column to fill in the 
parameters of the “Script Detail” column. Right-click the “Script Detail” column to 
change the parameters.

2. Under the Script Detail box, select an item in the parameter box.

3. Right-click the parameter box for the option menu to appear to the right of the 
selection.

4. Select the desired options (delete or insert the parameter box).

5. To add a new I2C command, select I2CM and then select the desired command 
from the list. 

6. Keep the I2CSTART, I2CWRTBYT and I2CSTOP parameters in the same order 
as shown below. Address bits A2, A1, and A0 are 0, 0 and 0, respectively, for the 
MCP3421/MCP3422 devices populated on the MCP3421/2 SOT-23-6 Evalua-
tion Board. See the MCP3421/MCP3422 data sheets for more information 
regarding address bit selection.

7. Change the fourth and fifth parameter values in the “Script Detail” column per the 
desired device operation (see Figure 2-9).

2.2.3 Saving and Executing the Script File

1. Type in any script name (e.g. MCP3421_WR) in the space under the “Script 
Name” field.

2. Click the Save Script button.

3. Click the Execute Script button.

- At this point, the PICkit™ Serial Analyzer transmits the I2C command to the 
MCP3421/2 SOT-23-6 Evaluation Board. The Busy LED on the PICkit™ 
Serial Analyzer will momentarily turn on and then turn off. If the LED remains 
on, a communications problem has occurred. Remove the PICkit™ Serial 
Analyzer from the computer and re-check the parameter values, including the 
order of parameters under the “Script Detail” column. Try again until the Busy 
LED goes off immediately after executing the I2C command.

- The saved file name appears in “Users I2C Scripts” column and can be 
reused any time by selecting the file name. 

Note: Note that the 0C in the configuration byte selects the following options:

-  Channel Selection: Channel 1

-  Conversion Mode: One-Shot Conversion 

-  Sample Rate(Resolution): 3.75 SPS (18-bit)

-  Gain Selection: 1x
 2023 Microchip Technology Inc. and its subsidiaries  DS50003483A-page 17
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FIGURE 2-9: PICkit™ Serial I2C Write Command.

2.2.4 Reading Conversion Data

1. Click on ReadAddrA8 in the “Example I2C Scripts” column to fill in the parame-
ters of the “Script Detail” column. Right-click the “Script Detail” column to change 
the parameters.

2. Under the “Script Detail” box, select an item in the parameter box.

3. Right-click the parameter box for the option menu to appear to the right of the 
selection.

4. Select the desired options (delete or insert the parameter box).

5. To add a new I2C command select I2CM and then select the desired command 
from the list.

6. Keep the I2CSTART, I2CWRTBYT, WAIT1, I2CRESTART, I2CRDBYTNLB and 
I2CSTOP (after 4 Bytes Received) parameters in the same order as shown 
below. Address bits A2, A1, and A0 are 0, 0 and 0, respectively, for the 
MCP3421/2 devices populated on the MCP3421/2 SOT-23-6 Evaluation Board. 
See the MCP3421/2 data sheets for more information regarding address bit 
selection.

7. Change the 4th, 5th, 7th, 8th, 12th and 14th parameter values in the “Script 
Detail’ column per the desired device operation (see Figure 2-10).

Once all parameters have been entered the script can be saved by clicking the Save 
Script button and then executed by clicking on the Execute Script button.

1. To change value 
click an empty 
box and type a 
new value. 

2. To delete or insert 
box choose the 
box and right click 
for options. 

3. Make sure the 
listed parameters 
are in the exact 
order parameters 
in “Script Detail” 
as shown here.

Bytes Transmitted = 02

Address+WR-CMD Byte = D0

Configuration Byte = 0C

Note: For a comprehensive explanation of the PICkit™ Serial Analyzer PC 
Software see DS51647C.
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FIGURE 2-10: PICkit™ Serial I2C Conversion and Read Command.

Bytes Received (Read) = 04

Address+WR-CMD Byte = D0

Bytes Transmitted = 01

Configuration Byte = 0C

Bytes Transmitted = 01

Address+RD-CMD Byte = D1

WAIT1 Delay LSB = 8B

WAIT1 Delay MSB = 02

Configuration Byte = 0C (Note: RDY Bit is ‘0’)

Conversion Data Low Byte = 4F

Conversion Data High Byte = FF 

Conversion Data Upper Byte = 00

 Results: 

 Input Voltage = 1.023578V

 Output Code: 0x00FF4F (= 65359 in Decimal)

 Output Code: (65359 x 15.625 μV (LSB))/PGA = 1.021242 V with PGA = 1

 Note: 1 LSB with 18-bit Resolution option: 15.625 μV
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Chapter 3.  MCP2221A Breakout Module
3.1 GETTING STARTED WITH THE MCP2221A BREAKOUT MODULE

3.1.1 MCP2221A Breakout Module and MCP3421/2 SOT-23-6 
Evaluation Board Hardware Set-Up

The following steps describe how to connect the MCP2221A Breakout Module to the 
MCP3421/2 SOT-23-6 Evaluation Board.

1. VDD selection: When using the MCP2221A Breakout Module the 0Ω R3 
resistor/jumper is recommended, i.e. not R1 or R2, to avoid contention between 
the power supplied by the MCP2221A Breakout Module and the power available 
from the mikroBUS header.

2. Configure the MCP2221A Breakout Module output supply voltage for either 3.3V 
or 5V via the J4 jumper.

3. Configure the I2C Bus SCL and SDA pull-ups via the JP2 and JP3 jumpers.

4. Connect the MCP3421/2 SOT-23-6 Evaluation Boards J3 pin header to the 
MCP2221A Breakout Module.

5. LED LD1 turns on when VDD is applied.

6. Connecting analog inputs: Connect unused pins (example, VIN-) to VSS for 
single-ended measurements.

7. Use the MCP2221A Breakout Module PC GUI to send I2C Write and Read 
Commands. See Section 3.2 “Creating Command List Files”.

8. Execute the MCP2221A Breakout Module Command List File and obtain the 
ADC conversion results. The conversion results appear in the MCP2221A 
I2C/SMBus Terminal GUI.

3.1.2 MCP2221A Breakout Module and MCP3421/2 SOT-23-6 
Evaluation Board PC Software Set-Up

The following steps describe how to set up the MCP2221A I2C/SMBus Terminal 
software to write the configuration bits of the MCP3421/2 devices and read the ADC 
conversion results.

1. Install the MCP2221A I2C/SMBus Terminal software onto a personal computer 
(PC).

2. Connect the USB cable between the MCP2221A Breakout Module and the PC.

3. Run the MCP2221A I2C/SMBus Terminal PC Software. The GUI will appear as 
shown in Figure 3-1.

CAUTION

The analog input pin has ESD diodes. Certain input conditions can damage the 
device. Please pay attention to the following conditions:

a) Do not apply input greater than the input range specified by the MCP3421 
and MCP3422 data sheets.

b) Apply input signal after VDD is powered-up.
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FIGURE 3-1: MCP2221A I2C/SMBus Terminal Window.

3.2 CREATING COMMAND LIST FILES

To establish communication between the MCP2221A I2C/SMBus Terminal and a 
MCP3421/2 SOT-23-6 Evaluation Board, a command list is needed. The following 
sections explain I2C Commands Lists for the MCP3421/2 Read/Write operations. 

3.2.1 Creating a Command List

To create an I2C Command List for Read and Write operations of the MCP3421/2 
devices, select I2C under the Protocol column. At this point, a new command row will 
automatically be added to the command list below the current command row. The 
following steps will be used to create a set of executable commands to Write the 
Configuration register.

3.2.2 Writing the Configuration Register

1. Select 7-bit for the “Address Length”.

2. Enter the Device Code (1101) and Address Bits (000) as a 7-bit value of 
‘1101000’ (0x68) for the “Address”.

3. Select Write for the “Operation”.

4. The “Register Index” is for SMBus operation only and should be left blank. 

5. The “Data” value (hex format) will specify the value to be written to the 
Configuration Register. 

6. The “PEC” (Packet Error Check) is for SMBus operation only and should be left 
blank. 

7. A “Delay” (in milliseconds) can be inserted following execution of the current 
command; i.e. between the current command the next command, if required. 

8. “Comments” can be added to describe the operation executed by the command.
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3.2.3 Saving and Executing the Command List

There are two ways to save the current Command List. 

1. Simply select File from the menu bar and select Save Command List.

2. Click on the Save button located at the bottom-left of the “Commands” dialog.      

There are also two ways to execute a command:

1. Click on the Send button located to the right of the “Comments” column. 

2. Click on the Send All button located at the bottom-right of the “Commands” 
dialog to execute all commands in the “Commands” dialog list. 

- At this point, the MCP32221A Breakout Module transmits the I2C Write 
command to the MCP3421/2 SOT-23-6 Evaluation Board. The 
“Received/Sent Data” dialog will display a summary of the command(s) 
executed, e.g. “> I2C Write, Address = 0x68, Data: 0C Delay = 0”.

- The “Received/Sent Data” dialog will also display an OK acknowledgment 
indicating the command was properly executed, or an Address NACK 
received non-acknowledgment indicating an error has occurred when sending 
the command (see Figure 3-2).

- It should be noted the Send All button is the only way to execute a Delay. 

FIGURE 3-2: MCP2221A Breakout Module I2C Write Command.

Note: Note that the 0x0C in the Data column selects the following options:

- Channel Selection: Channel 1

- Conversion Mode: One-Shot Conversion 

- Sample Rate(Resolution): 3.75 SPS (18-bit)

- Gain Selection: 1x
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3.2.4 Reading Conversion Data

1. Select 7-bit for the “Address Length”.

2. Enter the Device Code (1101) and Address Bits (000) as a 7-bit value of 
‘1101000’ (0x68) for the “Address”.

3. Select Read for the “Operation”.

4. The “Register Index” is for SMBus operation only and should be left blank. 

5. The “Data” value (hex format) will specify the number of bytes to be read from 
the device. The number of bytes will depend on the Sample Rate/Resolution set 
in the Configuration Register. After the conversion data has been read, any 
additional bytes requested will read the contents of the Configuration Register.

6. The “PEC” (Packet Error Check) is for SMBus operation only and should be left 
blank. 

7. A “Delay” (in milliseconds) can be inserted between the previous command and 
the current command, if required. 

8. “Comments” can be added to describe the operation executed by the command. 

Once all commands have been entered in the Command dialog the Command List can 
be saved by clicking the Save button (or File>Save Command List) and then executed 
by clicking on the Send All button (see Figure 3-3).

FIGURE 3-3: MCP2221A Breakout Module I2C Conversion and Read 
Command (Input Voltage 1.022778V).

Note: For a comprehensive explanation of the MCP2221A Breakout Module 
I2C/SMBus Terminal PC Software see DS50002282.

 Results: 

 Input Voltage = 1.022778V

 Output Code: 0x00FF4C (= 65356 in Decimal)

 Output Code: (65356 x 15.625 μV (LSB)) / PGA = 1.021195V with PGA = 1

 Note: 1 LSB with 18-bit Resolution option: 15.625 μV
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Appendix A. Schematic and Layouts
A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP3421/2 
SOT-23-6 Evaluation Board.

• MCP3421 Schematic

• MCP3422 Schematic
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A.2 MCP3421 SCHEMATIC
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A.3 MCP3422 SCHEMATIC
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Appendix B. Bill of Materials (BOM)
TABLE B-1: MCP3421 BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

3 C1, C3, C4 Capacitor, ceramic, 0.1 μF, 16V, 10%, 
X7R, surface mount, 0603

Taiyo Yuden Co., Ltd. EMK107B7104KA-T

1 C2 Capacitor, ceramic, 10 μF, 25V, 10%, X5R, 
surface mount, 0805

Murata Electronics® GRM21BR61E106KA73L

0 J1, J2 Connector, Header 2.54, male, 1x8, gold, 
5.84MH, TH

FCI 68001-108HLF

1 J3 Connector, Header-2.54, male, 1x6, gold, 
5.84MH, TH, R/A

FCI 68016-106HLF

0 J4 Connector, Header-2.54, male, 1x3, gold, 
6.10MH, TH, vertical

METZ CONNECT
GmbH

PR20203VBNN

1 LABEL1 Label, PCBA, 18x6 mm, Datamatrix, 
Assy#/Rev/Serial/Date

ACT Logimark AS 505462

1 LD1 Diode, LED, green, 3.2V, 20 mA, 430 mcd, 
clear, SMD 0603

Würth Elektronik 150060GS75000

0 R1 Resistor, TKF, 0R, 1/10W, surface mount, 
0603, AEC-Q200

Panasonic® – ECG ERJ-3GEY0R00V

0 R2 Resistor, TKF, 0R, 1/10W, surface mount, 
0603, AEC-Q200

Panasonic – ECG ERJ-3GEY0R00V

1 R3 Resistor, TKF 0R 1/10W surface mount, 
0603, AEC-Q200

Panasonic – ECG ERJ-3GEY0R00V

3 R4, R5, R6 Resistor, TKF, 4.7 kΩ, 1%, 1/10W, surface 
mount, 0603

Digi-Key® Electronics 311-4.70KHRTR-ND

2 R7, R8 Resistor, TKF, 1 kΩ, 1%, 1/10W, surface 
mount, 0603

Vishay/Dale CRCW06031K00FKEA

0 TP1, TP2 Misc., Test point, multi purpose, mini, black Keystone®

Electronics Corp.
5001

1 U1 Microchip, Analog, ADC-Delta Sigma 
18-bit MCP3421A0T-E/CH, SOT-23-6

Microchip
Technology Inc.

MCP3421A0T-E/CH

TABLE B-2: MCP3422 BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

1 C1 Capacitor, ceramic, 10 μF, 25V, 10%, X5R, 
surface mount, 0805

Murata Electronics GRM21BR61E106KA73L

5 C2, C3, 
C4, C5, C6

Capacitor, ceramic, 0.1 μF 16V 10% X7R, 
surface mount, 0603

Taiyo Yuden Co., Ltd. EMK107B7104KA-T

2 J1, J2 Connector, Header-2.54, male, 1x8, gold, 
5.84MH, TH – DO NOT POPULATE

FCI 68001-108HLF

1 J3 Connector, Header-2.54, male, 1x6, gold, 
5.84MH, TH, R/A

FCI 68016-106HLF

1 J4 Connector, Header-2.54, male, 1x6, gold, 
5.84MH, TH, vertical – DO NOT POPULATE

FCI 68000-106HLF
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1 LABEL1 Label, PCBA, 18x6mm, Datamatrix, 
Assy#/Rev/Serial/Date

ACT Logimark AS 505462

1 LD1 Diode, LED, green, 3.2V, 20 mA, 430 mcd, 
clear, surface mount, 0603

Würth Elektronik 150060GS75000

2 R1, R2 Resistor, TKF, 0R, 1/10W, surface mount, 
0603, AEC-Q200 – DO NOT POPULATE

Panasonic – ECG ERJ-3GEY0R00V

1 R3 Resistor, TKF, 0R, 1/10W, surface mount, 
0603, AEC-Q200

Panasonic – ECG ERJ-3GEY0R00V

3 R4, R5, R6 Resistor, TKF, 4.7 kΩ, 1%, 1/10W, surface 
mount, 0603

Digi-Key Electronics 311-4.70KHRTR-ND

4 R7, R8, 
R9, R10

Resistor, TKF, 1 kΩ, 1%, 1/10W, surface 
mount, 0603

Vishay/Dale CRCW06031K00FKEA

2 TP1, TP2 Misc., test point, multi purpose, mini, black, – 
DO NOT POPULATE

Keystone
Electronics Corp.

5001

1 U1 Microchip, Analog, ADC-Delta Sigma18-bit 
MCP3422A0T-E/SN, SOIC-8

Microchip
Technology Inc.

MCP3422A0T-E/SN

TABLE B-2: MCP3422 BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number
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